**Welcome to ProSeries® tax software**

<table>
<thead>
<tr>
<th>For information about this topic...</th>
<th>Look here...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting ready</td>
<td>Page 1</td>
</tr>
<tr>
<td>Installing ProSeries software for stand-alone use</td>
<td>Page 1</td>
</tr>
<tr>
<td>Setting up the ProSeries program</td>
<td>Page 3</td>
</tr>
<tr>
<td>Filing returns electronically</td>
<td>Page 6</td>
</tr>
<tr>
<td>Installing ProSeries software for network use</td>
<td>Page 8</td>
</tr>
<tr>
<td>Product licensing</td>
<td>Page 11</td>
</tr>
<tr>
<td>Keeping your ProSeries tax products up-to-date</td>
<td>Page 13</td>
</tr>
</tbody>
</table>

### Getting ready

- For assistance and current information about all aspects of getting started with ProSeries software, click the **Help** button on the ProSeries toolbar to open the Help Center or go to www.proseries.com/support.
- For information about What’s New with ProSeries for the current tax year (such as form and calculation changes) refer to the **ReadMe** files located in the Help Center.
- Reminders regarding operating systems in ProSeries System Requirements
  - Windows Vista increased to Service Pack 2 for recommended and minimum system requirements.
  - Windows 7 Professional or Ultimate added to recommended operating system requirements.
  - Windows 7 Home Premium added to minimum operating requirements.
  - 64-bit operating systems are now supported.
- Note about Internet Connection Requirements
  - Dial-up Internet connection is no longer supported. High-speed Internet connection is required for both recommended and minimum Internet connection requirements.
- For detailed information about current System Requirements, go to www.proseries.com/sysreq.

### Installing ProSeries software for stand-alone use

You install ProSeries software from files you download from ProSeries.com (via the Internet) or from a ProSeries CD.

1. Close all programs.
2. **If you’re installing from a ProSeries CD,** insert the CD into the CD drive.
   - **If you’re installing from an .EXE file** that you downloaded from ProSeries.com, start Windows Explorer, go to C:\Temp, then double-click the .EXE file.
3. In the **ProSeries Installation** dialog box, select **Install ProSeries Software**.
   - **Tip:** If you’re installing from a ProSeries CD and the **ProSeries Installation** dialog box doesn’t appear automatically, go to the Windows taskbar, select **Start**, then select **Run**. In the **Run** dialog box, type `x:\CDSETUP` (where x represents the letter of the drive containing the ProSeries CD), then select **OK**. In the **ProSeries Installation** dialog box, select **Install ProSeries Software**.
4. Follow the instructions on the screen. Specific dialog boxes are discussed next.
5. If a **System Warning** dialog box appears, select **Cancel**, correct the situation identified in the dialog box, then start the installation procedure again.

6. In the **Software License Agreement** dialog box, select **I accept the terms of the license agreement** if you agree to accept all the terms of the ProSeries License Agreement, then select **Next**.

   **Important:** If you find the terms of the License Agreement unacceptable, **do not install the software**. Select **I do not accept the terms of the license agreement**, then contact ProSeries Customer Service for a refund instead.

7. In the **Select an Installation Type** dialog box, select **Stand Alone**, then select **Next**.

8. In the **Select Destination Directory** dialog box, select **Next** to install ProSeries software in a `\PROWINyy` directory (where “yy” represents the last two digits of the tax year) on the drive that’s shown in the dialog box.

   **Tip:** If you want to install ProSeries software to a different drive or directory, click **Browse**. In the **Select Folder** dialog box, select the drive you want, type the folder name `\ProWinyy` in the **Folder name** field (where “yy” represents the last two digits of the tax year) after the drive you selected, then select **OK**.

9. In the **Product Selections** dialog box, select every ProSeries tax products that you expect to use, then select **Next**.

   **Tip:** If you used ProSeries software last year, products that were installed last year might already be selected. Products you haven’t purchased as unlimited will be installed as pay-per-return. You can install additional products later, as described in “Keeping your ProSeries tax products up-to-date” on page 13.

   ![Product Selections dialog box](image)

   **This section explains how to use this dialog box.**

   These check boxes are for federal products.

   The check boxes to the right of the **Federal Products** section are for state products.

   **Tip:** At least one federal product must be selected. If you select a state product, be sure to select the corresponding federal product.

10. If any of the products you selected aren’t available, you’ll see the **Installation Note** dialog box. Review the list of products that will be installed later, then click **OK**.

11. Review the information in the **Installation Details** dialog box, then click **Next** to install the ProSeries tax products you selected that are available.

   **Important:** If you see the **Installation Failed** dialog box, click **Help** to find a possible solution, then click **Exit** to exit the installation program.

12. **Restart Windows message.** If you are prompted to restart your computer, do so. If the installation program doesn’t resume, double-click the **ProSeries** shortcut icon on your Windows desktop to start the ProSeries program.

13. **Setup Complete.** If you leave the check mark in the **Launch ProSeries** option in the **Setup Complete** dialog box, the Connected Customer Wizard begins when you select **Finish**.
**Tip:** If you see the **ProSeries Installation** dialog box, select **Exit** to return to the Windows desktop, then start the ProSeries program by double-clicking the **ProSeries** shortcut icon. The Connected Customer Wizard will begin.

### Troubleshooting suggestions

If you have difficulty installing or starting the ProSeries program:

- Start your Internet browser, then go to http://www.proseries.com to search for additional troubleshooting solutions.
- Refer to http://www.proseries.com/support for ProSeries Technical Support contact information. To save time, gather as much information as possible, including any error messages.

### Setting up the ProSeries program

The first time you start the ProSeries program, the Connected Customer Wizard helps you set up the program if there’s a valid Internet connection.

- **Firm information.** Retrieves the name and address of your firm.
- **Product licensing.** Licenses your ProSeries tax software to your firm.
- **Product updates.** Downloads and applies the updates for installed products, if any.
- **New products.** Downloads and installs not-yet-installed products, if any.

**Tip:** If the computer doesn’t have a valid Internet connection, a dialog box asks if you want to start the Internet Connection Setup Wizard. Select **Yes** to establish an Internet connection, or select **No** to establish a valid Internet connection at a later time.

### Using the Connected Customer Wizard

1. In the **Connected Customer** dialog box, select **Next**.
2. Enter or verify your Customer Number and the ZIP code in the **Customer Information** dialog box, then select **Next**.

![Customer Information dialog box](image)

These numbers should match the Customer Number and ZIP code that are printed in the Sold To: area of your packing slip.

A different Customer Number and ZIP code might appear in the Ship To: area of your packing slip.

3. Select **Next** after the Connected Customer Wizard finishes the setup tasks.
4. Review the information in the **Verify Firm Information** dialog box carefully. ProSeries program prints this information on all returns prepared by your firm.
If the information is correct, select Yes. If the information isn’t correct, select No. Select Next, then go to Step 8 if you selected Yes or go to Step 5 if you selected No.

5 Enter or edit your firm’s name and address in the Enter Firm Information dialog box, then select Next.

6 The wizard transmits the updated information to an Intuit server, or a dialog box instructs you to call Customer Service. Select OK to continue.

7 Review the firm and product information in the Product Licenses dialog box.

8 If the ProSeries Update program downloads and installs products and product updates, review the status of each product ProSeries Update dialog box, then select Close.

When the Connected Customer Wizard or ProSeries Update program finishes, the ProSeries program starts. The first time the ProSeries program starts, the Prior Year Settings Transferred dialog box appears if the program was able to transfer the preferences and settings you used with last year’s program.

Important: The ProSeries Login dialog box opens if (and only if) you used the Access Rights feature in last year’s ProSeries program and last year’s Access Rights information was transferred. Enter a valid User Name and Password, then click OK to proceed.

Using the Options Setup Wizard

The Options Setup Wizard usually automatically runs the first time the program starts. If it does not automatically start, click the Help button on the ProSeries toolbar then click Options Setup Wizard. The Options Setup Wizard helps you set up ProSeries options. Most Options Setup Wizard dialog boxes are self-explanatory. Note the following:

- The second dialog box asks you to select Express Setup or Custom Setup.
  - If you select Express Setup, you see the Options Setup Wizard dialog boxes for the ProSeries options you need to set before you complete returns.
  - If you select Custom Setup, you select the areas of the program you want to set up, then you see dialog boxes for those areas of the program.
- When the Congratulations dialog box appears, select Finish to save the options that you selected.

You can set up E-File options and Bank Products Enrollment/Registration Information using the Options Setup Wizard.

For more information about offering bank products through Santa Barbara Bank & Trust or Refund Advantage:

- Use the Search Help feature on the toolbar or in the Help Center.

The next sections discuss “Entering firm and preparer information” and “Entering global billing information” in some detail.

Tip: For information about a field in a dialog box, right mouse click the field, then select About <Field> on the pop-up menu.

Entering firm and preparer information

If you completed the Connected Customer Wizard, you’ll see your firm’s name and address in the gray area of the Firm Information section.

Enter other information about your firm in the fields below the gray area. If the firm will be filing returns electronically, enter the firm’s Electronic Filing Identification Number (EFIN) and the name of the person that ProSeries Technical Support can contact if necessary.
During the product licensing procedure, your firm’s name and address are retrieved from an Intuit Internet server, then entered here.

Enter other information about your firm here.

Enter preparer and ERO information in this section.

To move to new fields, press ENTER or TAB, or use your mouse.

Enter information about each of the firm’s preparers in the Preparer / Electronic Return Originator (ERO) Information section of the dialog box. If preparers will be filing returns electronically, also enter ERO Practitioner PIN, ERO Contact Name, and Electronic Filing Identification Number (EFIN) information in this section as applicable.

Tip: If the ProSeries program transferred preparer information from last year’s program, just edit the information as necessary.

Entering global billing information

Use the Global Billing Options dialog box to set the billing options that you want to use for all clients. If the ProSeries program transferred global billing information from last year’s program, just edit the information as necessary.

This dialog box helps you set up:

1. Tax Preparation Fees
2. Hourly Charges
3. Per Form Charges
4. Miscellaneous Fees and Adjustments
5. Discounts
6. Sales Taxes
7. Standard Paragraphs

Transferring data from last year’s ProSeries client files

The first time you start the ProSeries program, you can transfer relevant data from last year’s client files to new ProSeries client files for this year. If you used ProSeries software last year, select Yes to go to the Transfer window, then do the five steps listed on the left side of the Transfer window.

Electronic filing. If last year’s return was marked for electronic filing, that selection is transferred to this year’s return.

Important: If your firm will be filing returns electronically from more than one stand-alone computer, and each computer is using the same EFIN, change the starting number in the DCN counter in the Electronic Filing section.
of the **Options** dialog box in the ProSeries program on all but one computer before opening any returns. See “If more than one computer will be using the same EFIN” on page 7.

1. Select the type of transfer you want to perform from the list of alternatives.
2. Select the location of your existing client files.
3. Select a location for the new client files.
4. Select the client files that you want to transfer data from, or click the **Select All** button.
5. After you’ve selected one or more clients, click **Transfer**.

The **Transfer Log** dialog box opens when the ProSeries program finishes transferring client data. Review the information, then select **Close** to go to HomeBase.

---

### Filing returns electronically

ProSeries/Electronic Filing software is installed with ProSeries tax products that support electronic filing.

For detailed information about electronic filing:

- Go to http://www.proseries.com, select **Products**, then select **Electronic Filing**, or
- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Click the **Help** button on the toolbar, select **User’s Guide** in the Help Center, then go to chapter 20, “Electronic Filing.”

### Establishing an Internet connection

To file electronically, the computer on which the ProSeries program is installed must be able to connect to the Internet. If you don’t have an Internet connection, you must first sign up for service with an Internet Service Provider (ISP). Once you have an ISP, go to the **Help** menu, select **Internet Connection Setup**, then follow the instructions on the screen.

### Setting up the ProSeries program for electronic filing

Take the following steps to set up the ProSeries electronic filing options.

1. Go to the **Help** menu and select **Options Setup Wizard**.
2. In the first **Options Setup Wizard** dialog box, select **Express Setup**.
3. **EFINs**. In the **Firm/Preparer Information** dialog box, enter the firm’s Electronic Filing Identification Number (EFIN) in the **Firm Information** section, and enter preparers’ Electronic Filing Identification Number.
Numbers (EFINs) in the **Preparer Information** section. After you enter an EFIN, complete the corresponding **Efile Contact Name** fields.

**PINs.** PINs (Personal Identification Numbers) are used as electronic signatures. Enter each preparer’s PIN in the **ERO Practitioner PIN** field. A Practitioner PIN is any five-digit code (except all zeros) chosen by each preparer.

**Important:** The IRS requires that tax practitioners e-file individual income tax returns with Practitioner PINs or taxpayer Self-Select PINs. Tax practitioners can’t submit a paper signature for e-filed returns by using Form 8453 anymore. A redesigned Form 8453 is used only to transmit required supporting paper documents.

---

4 In the **Filing Client Returns Electronically** dialog box, select **Yes, some returns may be filed electronically.**

5 Complete the remainder of the Options Setup Wizard.

---

**If more than one computer will be using the same EFIN**

When ProSeries software is installed on a computer, the DCN (Declaration Control Number) counter is set at “00001.” The program assigns that number to the first federal return that’s marked for electronic filing, then increments the DCN counter by “1.” As each subsequent federal return is marked for electronic filing, the program assigns the current DCN to that return, then increments the DCN counter by “1.”

**Important:** If your firm will be filing returns electronically from more than one non-networked computer, and each computer is using the same EFIN, change the starting number in the DCN counter in the **Options** dialog box on all but one computer before preparers start to transfer or prepare returns. By advancing the DCN counter sufficiently on each “additional” stand-alone computer, each return marked for electronic filing will be assigned a unique DCN. For example, advance the DCN counter to “01001” on the second computer, to “02001” on the third computer, and so on.

**Tip:** If a computer will be using a unique EFIN, it’s not necessary to change the starting number in the DCN counter for that computer.

To change the starting number in the DCN counter for a computer:

1 Go to the **Tools** menu, then select **Options.**
2 Select **Electronic Filing** in the left side of the **Options** dialog box.
3 Go to the **DCN Counter** field and increase the number.

**Tip:** The Options Setup Wizard also provides a way to adjust the DCN counter.
Installing ProSeries software for network use

Installing and setting up ProSeries software for network use involves the following three steps:

- **Step 1: Install to this computer (ADMIN workstation)**
- **Step 2: Complete Licensing (Connected Customer)**
- **Step 3: Install to other network computers (USER workstations)**

Note that certain details vary from system to system. If you have additional questions about network installation:

1. Start your Internet browser, then go to http://www.proseries.com.
2. From the ProSeries.com home page, select **Support**.
3. Type a question in the **Search the Knowledge Base** field, then select **Search**.

**Tip:** If you want help optimizing ProSeries software on your network, your Network professional can go to http://www.proseries.com, login to My ProSeries, then send an e-mail to ProSeries Technical Support.

Prepare your networked computer system

Before you can install ProSeries software, you must prepare your networked computer system. The specific steps appropriate for your system depend on the type of network and the way it’s set up. The table below explains some network-related terms.

<table>
<thead>
<tr>
<th>Term</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client-server network</td>
<td>A network setup where only one computer (the server) shares resources used by one or more workstations (the clients).</td>
</tr>
<tr>
<td>Peer-to-peer network</td>
<td>Up to 10 computers that are linked together. One or more systems may share resources.</td>
</tr>
<tr>
<td>Mapped drive</td>
<td>Any drive or shared resource that has a drive letter assigned to it.</td>
</tr>
<tr>
<td>ProSeries ADMIN workstation</td>
<td>The computer from which ProSeries software is installed to the server or serving computer. You can designate any computer to be the ProSeries ADMIN workstation (including the network administrator’s computer), but once you choose a ProSeries ADMIN workstation, it should remain the ProSeries ADMIN workstation throughout the tax season.</td>
</tr>
<tr>
<td>ProSeries User workstation</td>
<td>A computer that runs the ProSeries program and accesses the ProSeries network components from the shared folder.</td>
</tr>
<tr>
<td>Shared folder</td>
<td>The folder that is set up by the Network Administrator to be shared in the network system. The ProSeries shared folder is the location where ProSeries network components and client files reside.)</td>
</tr>
<tr>
<td>Primary file location</td>
<td>This is the location where the program stores all current-year client files. This location can be set only from the ProSeries ADMIN workstation.</td>
</tr>
</tbody>
</table>

For instructions related to shared folders, mapped drives, rights, and permissions, refer to the documentation for your operating system and/or network software. If you have additional questions about preparing your networked system for the network version of ProSeries, go to http://www.proseries.com, select **Support**, type a question in the **Search the Knowledge Base** field, then select **Search**.

Take the following steps before you begin the ProSeries installation procedure.

1. Decide which drive on the server (if a client-server network) or the serving computer (if a peer-to-peer network) you will install ProSeries shared network components.
2. On the drive you chose, create a folder named **ProSeries**.
3 Make the ProSeries folder a shared folder, and assign it the name “ProSeries.”

4 Within the ProSeries folder, create a folder named ProNetyy (where “yy” represents the last two digits of the tax year).

5 Decide which computer will be the ProSeries ADMIN workstation. Use the following information to help you decide.
   - Internet access. An Internet connection is required.
   - If a client-server network. You install ProSeries software from the ProSeries ADMIN workstation to the server’s hard drive. The ProSeries ADMIN workstation and the server are two different computers. The ProSeries ADMIN workstation can be used as a workstation, but the server is not used as a workstation because doing so can degrade network performance.
   - If a peer-to-peer network. You install ProSeries software on the ProSeries ADMIN workstation’s hard drive. The ProSeries ADMIN workstation can be used as a workstation.
   - Rights. The ADMIN workstation is the only computer that has rights to at least some aspects of the following features: Product Updating, Customer Information, Primary File Location, Firm Name and Address, Master Password, Electronic Filing Password, Bank Products Registration Information, Database Maintenance, and HomeBase Tune-up.

6 Make sure a drive is mapped to the ProSeries folder on the server or serving computer. Make sure the ProSeries ADMIN workstation has the appropriate rights and permissions.

7 Go to each computer that will serve as a ProSeries User workstation, then make sure a drive is mapped to the ProSeries folder on the server or serving computer. Make sure each User workstation has the appropriate rights and permissions.

Map drive factors to consider

We recommend you use mapped drives (rather than UNC), and that the drive with the ProSeries shared network components be mapped to the same drive letter for all workstations.

- Mapped to same drive letter. If you’re an existing ProSeries network user and have all computers mapped to the same drive letter, you don’t have to change anything. Install ProSeries software as you did in prior years.
- Mapped to different drive letters. If all of your workstations are mapped to a network shared folder using different drive letters, you don’t have to re-map the workstations.
- New computers. If you’re an existing ProSeries network user and you’ve added new computers to your network, we recommend you set them up the same way as the existing workstations on your network.
- New user. If you are installing ProSeries software for the first time, you can install ProSeries shared network components directly to a shared folder without mapping drives. You can run the workstation installation and setup from all other computers by accessing this shared folder.
- UNC instead of mapped drives. UNC stands for “Universal Naming Convention” or “Uniform Naming Convention.” UNC uses the following format:

  \server-name\shared-folder-path

If you use UNC instead of mapped drives, the shared folder doesn’t have to be mapped to a network letter as long as all workstations can access the shared folder. However, if you use UNC instead of mapped drives, you must use UNC exclusively.

Step 1 and Step 2: Install and set up ProSeries software from the ADMIN workstation

Installing ProSeries software from the ADMIN workstation for network use is similar to installing ProSeries software for stand-alone use with the following exceptions:
In the **Select an Installation Type** dialog box, select **Network**, then select **Next**.

When the **Review Network Installation Steps** dialog box appears, review the summary of the three steps required for network installation, then click **Next**.

In the **Computer Name** dialog box, enter a name for the current workstation (such as the name of the person who typically uses the workstation), then click **Next**.

In the **Choose Destination Location** dialog box, accept the recommended locations for the **Local Folder** and **Network Folder** unless:

- **Local Folder**. You want the **ProWinYY** folder (where “YY” represents the last two digits of the tax year) on a local drive other than C:.
- **Network Folder**. If the suggested location isn’t appropriate or the **Network Folder** field is blank, select the **ProNetYY** folder (where “YY” represents the last two digits of the tax year) within the **ProSeries** folder that you created on the server or serving computer.

If you accept:

* The location shown in the **Local Folder** field, and
* The location shown in the **Network Folder** field (if a location is shown), then

Click **Next**.

If you don’t accept the **Local Folder**:

- Select the local drive where you want to install the ProSeries program.
- Go to the **Path** field, type **ProWinYY** (where you type the last two digits of the tax year in place of “YY”) after the drive that you selected, then click **OK**. If you are prompted to create the ProWinYY folder, click **Yes**.
- Continue with Step 5.

If you don’t accept the **Network Folder**:

- Select the drive where you want to install the ProSeries shared network components.
- Go to the **Path** field, then type “**ProSeries\ProNetYY**” (where you type the last two digits of the tax year in place of “YY”) after the drive you selected, then click **OK**. If you are prompted to create the ProSeries or ProNetYY folder on the drive that you’ve selected, click **Yes**.
- Continue with Step 5.

When the **Step 2: Complete Licensing (Connected Customer)** dialog box appears, review the summary of the next steps, then click **Next**.

**Connected Customer Wizard**. If the product licensing information that was downloaded by the Connected Customer Wizard didn’t include a Network License. You’ll see the **Your Network License is Missing** dialog box.

- Select **License Now** then call Customer Service to resolve the issue, or
- Select **Continue without licensing** then click **OK**.
7. **User workstation installation instructions.** Click Print so you can refer to a printed copy of the instructions while you are installing the software and setting up each user workstation.

**Step 3: Set up each ProSeries User workstation**

Installing ProSeries software to each workstation is similar to installing ProSeries software for stand-alone use with the following exceptions:

From each ProSeries User workstation:

1. Go to the Windows taskbar, click **Start**, select **Run**, enter the path that’s identified in the User workstation installation instructions, then click **OK**.

   **Tip:** That path will probably be `x:\ProSeries\ProNetYY\WKSTN\setup.exe`, where `x` represents a drive on your system (but not necessarily Drive X), and “YY” represents the last two digits of the current tax year.

   ![Run dialog box with path example](image)

   This example shows a path that starts with Drive N.

   This field is not case sensitive.

   Letters can be upper-case or lower-case.

2. Follow the instructions on the screen.

3. In the **Choose Destination Location** dialog box, accept `C:\ProWinYY` as the recommended location for the **Local Folder**, or select a different local drive for the **ProWinYY** folder (where YY represents the last two digits of the tax year).

4. In the **Computer Name** dialog box, enter a name for the User workstation (such as the name of the person who typically uses the workstation), then click **Next**.

5. The **HomeBase Reconciliation** dialog box appears if the ProSeries program detects that the HomeBase database on the User workstation needs to be updated with the latest information in the client files stored with the shared network components.

6. **Network License.** If the product licensing information that was downloaded by the Connected Customer Wizard didn’t include a Network License, follow the instructions in the **Network License Missing** dialog box to resolve the situation.

   **Important:** You can’t print or e-file returns until your ProSeries software is licensed.

---

**Product licensing**

Product licensing is a system that licenses your ProSeries tax software to your firm. Product licensing is required before you can print returns, file returns electronically, or create PDF files that contain returns. Products that aren’t licensed for unlimited use can be used on a pay-per-return basis.
Product licensing uses your Customer Number and ZIP code with information in Intuit’s records to deliver the following to your ProSeries tax software:

- An unlimited-use license for each ProSeries tax product and ProSeries electronic filing product that you’ve purchased for unlimited use—even if those products haven’t been installed yet
- Your firm’s name and address
- A network license (if you purchased ProSeries/Network Version)

**Tip:** You can make minor changes to your firm’s name and address (such as changing “Dr.” to “Drive”) after ProSeries product licensing has occurred.

ProSeries product licensing can be performed using the Online method or the Manual method. For most ProSeries users, product licensing occurs online automatically.

### Automatic, Online product licensing

The Connected Customer Wizard performs product licensing automatically when:

- You install ProSeries tax software for stand-alone use on a computer that has an Internet connection
- You install ProSeries tax software for network use from a computer (referred to as the ProSeries Admin workstation) that has an Internet connection

**Important:** When ProSeries is installed for network use, product licensing must be initiated from the ProSeries Admin workstation. Product licensing information is shared by all computers that have been set up as ProSeries workstations. See the ProSeries Network Installation Guide for more information.

Be sure to read “Keeping your ProSeries tax products up-to-date” on page 13 of this guide.

### Product licensing using the Manual method

If automatic, Online product licensing hasn’t been performed (as explained above), you’ll see the message “Product Licensing Required” in the HomeBase Message Center. When you click that message, you see a **License Products** dialog box that includes two options: **Online (Recommended)** and **Manual**. Select **Manual**, then select **OK**. You’ll see the **License Products** dialog box shown below.

**Tip:** Ways that you can contact Intuit for manual product licensing include:

- **Automated Touch Tone phone service** (call 1-800-723-0692)
- **Online service** (go to http://www.proseries.com, then select **Product Licensing**)

1. Verify your Customer Number and ZIP code.
2. Enter your firm’s name and address. (This information must match the information contained in Intuit’s records.)
3. Contact Intuit using one of three methods. You will receive a unique Activation Code from Intuit.
4. Enter the Activation Code, then click **OK**.
Product licensing with multiple, non-Internet computers

If you installed ProSeries for stand-alone use on computers that don’t have an Internet connection and you don’t want to perform product licensing for each computer using the Manual method, here’s a convenient way to copy your firm’s product licensing information from one computer to other computers.

1. From the computer with your firm’s product licensing information, go to the File menu, select Copy Product License, then use the dialog box to save the product license file to a network location or removable media (such as a 3.5-inch disk).

2. From each computer that requires product licensing, go to the File menu, select Retrieve Product License, then use the dialog box to retrieve the product license file that you copied to the network location or removable media.

Tip: Repeat this procedure if you update the firm’s product licensing information.

Updating your firm’s product licensing information

Update your firm’s product licensing information when:

- You purchase additional ProSeries tax products or additional ProSeries electronic filing products for Unlimited use, or
- You purchase ProSeries/Network Version, or
- The software or an Intuit ProSeries representative instructs you to update your product license information

If either of these situations occur, go to the Tools menu, select License Products, select Online, select OK, then simply wait for the product licensing procedure to conclude.

Tip: If the computer isn’t connected to the Internet, go to the Tools menu, select License Products, select Manual, select OK, then follow the instructions in the License Products dialog box shown on page 12.

For more information about product licensing:

- Use the Search Help feature on the Help toolbar or in the Help Center, or
- Click the Help button on the toolbar, select User’s Guide in the Help Center, then go to chapter 4, “Setting Up ProSeries Features.”

Keeping your ProSeries tax products up-to-date

As soon as a ProSeries tax product or tax product update becomes available, it is posted to a ProSeries Internet server. Getting products and updates via the Internet helps you have the most up-to-date versions of the tax products you use.

Network: Most product updating activities must be performed from the ProSeries ADMIN workstation.

Task Scheduler

Use the Task Scheduler to Save time and never miss a critical update by scheduling selected tasks to run automatically. Your computer must be running and connected to the Internet when tasks are scheduled to run.

Using the Task Scheduler program

1. In ProSeries, go to the Tools menu, select Options, then select Task Scheduler.
2 Make sure the Download New/Update Existing Products task is enabled.
3 To change the Task Scheduler schedule, select Modify.

Using the ProSeries Update menu

1 In ProSeries, go to the Update menu and select Update Installed Products if you don’t want to select additional products for installation.
2 In ProSeries, go to the Update menu and select Select and Download New Products if you want to select additional products for installation.

Tip: If ProSeries isn’t running, click the Start button on the Windows desktop, select Programs, select ProSeries, then select ProSeries Update.